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SEARCH FOLDERS 

Search Folders are an excellent tool for locating messages in any 
folder in your mailbox based on criteria within the message. This is 
useful when regularly searching for the same items containing these 
criteria. It is analogous to a query in a database. Note: Search Folders 
do not store messages, but simply reflect the messages currently in the 
mailbox which contain criteria defined in the search folder. Thus the 
user is always going to see the most current items. 

 

 To create a Search Folder, click Folder on the Ribbon, Search Folder select 
from the default preset Search Folder list and define the parameters in the 
dialog box. 

 To create a global All Email Search Folder, in the above dialog box scroll 
down and click on Create a Custom Search Folder.  Do NOT select any 
criteria for this Search Folder so that it does not filter any messages, but 
instead allows all messages to be displayed. This enables the user to view in 
one list any and all messages in any and all folders. This becomes an 
excellent tool for managing messages more quickly and efficiently. 

 

 Once this Search Folder has been created, it is recommended that it be 
dragged up to the Favorites panel in the Navigation Pane for easy access. 

TASK PRODUCTIVITY 

 Always align tasks to personal or professional goals – if necessary, develop 
the habit of specifying the goal that a task relates to as reinforcement 

 Use the Task folder to review your Follow 
Up Flag items 

 Drag message items to Task icon in the 
Navigation Panel to create a new 
Outlook Task item based on message 
content. 

 Turn on the To Do panel in Calendar to 
view pending tasks below appointments 

 Categorize all Tasks so that you can search based on category assigned 

 Larger tasks should be transferred to your Calendar as appointments to book 
appropriate time. Otherwise, set aside time daily to review and complete 
tasks that are quick and easy to complete 

 
CONTACT PRODUCTIVITY 

 Create and apply Categories to all 
contacts, then create a custom View 
with filter based on the categories 
assigned. To use a group of contacts 
based on a Category, simply switch 
view. Then perform a mail merge to 
create a form letter or labels out of 
the contact list in Outlook. 

 Messages from new contacts can be 
dragged and dropped onto your 
Contacts icon to generate a new 
Outlook contact item. 

 Create custom fields from the Field 
Chooser to further organize your 
contact details. Use Categories and 
Grouping to facilitate communication 
with your contacts 

 Select the Contact group that you 
want to mail merge to then click the 
Mail Merge  button to begin the 
merge process. 

 

NAVIGATION PANE – FAVORITES PANEL 

Now that we have implemented the features and tools that will help 
us maintain an organized Inbox, the final step is to the make specific 
folders available at the top of the Navigation Pane on the left side of 
your Outlook Window. The three that I recommend are: 

 All Email (a Search Folder as the previous section described) 

 Unread Mail – this will list any Unread items 
that may have been automatically 
processed by a rule to go into a folder, but 
which you still need to read 

 Follow Up – this will list all messages which 
may include those in a folder that have 
been flagged for follow up 

 To add these three folders in the Favourites panel, expand your Search 
Folders and click and drag each of these into the Favorites panel. They will 
remain there until removed. 

CALENDAR PRODUCTIVITY 

 Now that you have created Categories, I recommend applying them to your 
Calendar entries to allow the colours to display on the calendar items so that 
it is clear where your time is being allocated.  

 Use your Calendar as your priority scheduling tool and book time into each 
week – preferably on a Friday afternoon for the following week – to 
organize your next week’s activities 

 Drag and drop email items which reference new appointments onto your 
Calendar icon to automatically generate a new Outlook appointment item. 

RESOURCES 

 Microsoft - https://support.office.com/en-GB/article/Outlook-2013-videos-
and-tutorials-f83e8e60-0bab-47eb-8f6e-c2ecb73124d8  

 Jill Duffy - Excellent 300 page eBook for $2.99 US 
http://getorganized.pressbooks.com   

 Get Organized: 5 Tips for Microsoft Outlook - 
http://www.pcmag.com/article2/0,2817,2418518,00.asp   

 http://www.wikihow.com/Organize-Yourself-Using-Microsoft-Outlook  

 Overall office and home organization tips free 6 video series - 
http://simplesolutionsorganizers.com/landing/get-organized-free-video-
series  

 Take Back Your Life - https://www.youtube.com/watch?v=G-sNOskt-no  

 
O U T L O O K  P R O D U C T I V I T Y   

T I P S  &  T E C H N I Q U E S  
 

PRODUCTIVITY CONCEPTS 

Defining Goals and Objectives 

The most important task when using any system for 
organizing information is to be clear on goals and objectives. 
Here is an illustration of the process of organization: 

Productivity Lifecycle 

 

In this illustration we can see that the starting point of 
organization is the planning and prioritization process. All of 
the actions we perform should contribute to the 
achievement of these goals. Outlook has many tools and 
features that help us at each step in the Productivity Lifecycle 

Goal Categories 

There are several goal categories to consider when defining 
goals 

 Business goals 

 Personal goals 

 Project goals 

Each of these can be incorporated into Outlook and 
organized using Folders and Categories as well as automated 
using QuickSteps and Rules as we will examine in this 
reference material. 

EMAIL PRODUCTIVITY 

The most common component that people spend most of 
their time working with in Outlook is email. Receiving and 
processing email, therefore, is the most time-consuming. For 
this reason, it’s important to be able to quickly make decisions 
about what each incoming and outgoing messages requires 
in order to act on it. Much of these decisions can be 
automated. But before we do this we need to follow some 
guidelines for minimizing or eliminating unnecessary email. 

Minimizing Incoming and Outgoing Email 

 Use the phone instead of email 

 Meet in person 

 Use available internal or external chat services 

 Don’t sign up for unnecessary newsletters or other services 

 Ask to be removed from distribution lists 

 Avoid sending unnecessary emails 

 Avoid giving out business cards unless absolutely necessary 

 Keep your email address confidential 

 Always use the BCC (Blind Courtesy Copy) field when sending to a 
large distribution list 

 
INFORMATION MANAGEMENT 

4 D’s of Information Management 

Wherever possible apply one of these four actions on each 
incoming message as well as outgoing email. 

 

REMEMBER: Touch each message ONLY ONCE wherever 
possible. 

Delete It! 

 For many users the bulk of incoming messages can be deleted once 
actioned. Doing this promptly saves having to revisit the email later and 
make the decision. 

Do It! 

 If the message requires an action and it can be completed within 2 
minutes, perform the action immediately. 

Defer It! 

 This is the more challenging decision to make when processing email 
but if you have a system in place, the folder or category decision can be 
made a lot easier. 

Delegate It! 

 Clearly, this only applies if the user has someone to whom he/she can 
delegate, but if applicable, Outlook has tools to perform this action. 

Staging Outlook 

Preparing the Outlook environment is essential if you want to 
take advantage of all the productivity tools available which help 
you to promptly process Outlook information. Here are the 
specific tools recommended for easy access to the features used 
for organizing in Outlook: Quick Access Toolbar – customize this 
feature to add tools as follows: 

 Mail Tools: New, Item, Reply, Forward, Navigate Up/Down, Categorize, 
Move to Folder, Rules, Reading Pane, Delete, Collapse All/Expand All, 
Find a Contact, Send/Receive, Filter Email 

 Calendar Tools: Day, Week, Month Layouts 

 Contact Tools: Show in Groups, Group By, Field Chooser 

 Task Tools: - Complete/Incomplete check 

Several of the above buttons function in all Outlook components, 
such as New Item. 

In addition, you will want to enable the Favourites section in the 
Navigation Pane. We will be adding specific folders here. 
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EMAIL AND CONTACT ORGANIZATION 

Folders and Categories 

Folders have been the conventional option for organizing email in 
Outlook for a number of years, but Categories are increasingly being 
adopted in many information management systems because of their 
versatility and power. Let’s compare the two: 

 Categories are applied to an email 
message and stay with the 
message wherever it’s moved 

 Many* Categories can be created 

and applied to any message 

 25 Category colours are available 
and can be applied to multiple 
Category names 

 Categories do not allow for  
sub-categories 

 Categories can be applied to ANY 
Outlook item – Email, Calendar, 
Contacts, Tasks, etc. 

 Folders contain email messages 

 Many* Folders can be created to 
store and organize messages but a 
message can only be stored in one 
Folder at a time (unless copied) 

 Folders do not have colour 
attributes 

 Folders do allow for sub-folders 

 Folders are primarily used only on 
email (though folders can be 
created in other Outlook 
components) 

*There may be technical specification limits such as the Outlook data file size 
but you are unlikely to ever reach that limit. 

For this reason, you will find that Categories – also referred to as Tags 
or Labels – give you much more flexibility in how you Sort, Search, 
Filter, Group messages in any folder. Furthermore, since Categories 
can be applied on any Outlook item, this can become a powerful way 
to search across all Outlook components – Mail, Calendar, Contacts 
and Tasks – for criteria that apply to all. Since Categories are applied 
TO an email message (or any item), it follows that item no matter 
where it is located. Even if it’s archived to a PST folder, a user can still 
find it based on the category assigned. There are a myriad of ways of 
leveraging the Categories feature. We will take a look at a few here.  

Folders 

The key to managing email consistently is having a system. The simpler 
the better, because when processing huge volumes of email, you will 
need to be able to make decisions quickly. It’s also useful to keep your 
Inbox clear and having fewer folders makes this easier to accomplish. 
For example, I’ve created the following three folder standard for email 
that works quite effectively because I can easily decide which of the 3 
folders any message will go into. 

 

Note: These 3 folders are numbered to allow 
the user control over the positioning in the 
navigation pane. They will automatically 
place themselves below the four core system 
folders Inbox, Drafts, Sent Items and Deleted 
Items. Any items that arrive in the Inbox can 
either be immediately moved into these 
folders or be actioned first, then moved. We 
will want to complement the use of folders 
with Categories as described below. 
Furthermore, we are able to use QuickSteps 
and Rules to move messages into these 
folders based on criteria in the message. 
Finally, we can use Search Folders to display 
messages in a single list should we need to 
view them together.  

You can decide what your folders will be named according to your 
own working style and the type of information that you manage. The 
key is to keep folders to a minimum. If you are inclined to have many 
folders, consider instead applying Categories to your messages and 
roll up the messages in sub-folders to a main folder. It is a much more 
versatile option for managing information.  

 To create a folder select the Ribbon tab Folder, click New Folder and enter 
desired name. Using numbers at the beginning will place at the top of list. 

 Categories 

More and more Categories are being used to help in the process of 
organization. They function quite differently than folders as they are 
applied TO an email message. Since Categories have colour they can 
be an effective way to easily identify messages or other Outlook items 
quickly and action them. Here are some examples of Categories: 

 

Plan your use of Categories carefully and consider how you might use 
them across ALL Outlook components. Examples: 

 Clients 

 Locations 

 Departments 

 Projects 

 Activities 

 Associations 

Be sure to set the Quick-Click default category so that you may easily 
apply the most common Category to email messages with the left 
mouse button. 

 To apply a Category, right-click in the Category column beside one or more 
selected messages and left-click the category name or select the Categories 
button on the Home tab on the Ribbon and choose a Category to apply. 

Flags 

Flags are used to quickly prioritize incoming communication with 
based on actions required in the email. As mentioned above, when a 
decision must be made on an item to do an action and that action 
must be postponed, flags can include reminders which are an effective 
way to see a reminder box appear on a date and time that is set with 
the flag. 

 

 To apply a Flag on any item including Calendar, 
Contact, Task items, right-click the Flag icon to the 
right of the message item, select from the context 
menu and/or click Add Reminder to customize the 
Reminder details.  

 For custom flags/reminders, you can enter any 
reminder message in the Flag to: field. This will 
appear at the top of the message as well as in the 
Reminder dialog box on the date/time specified. 

 
AUTOMATING EMAIL MANAGEMENT 

Conditional Formatting on a View 

It may be a useful to apply conditional formatting on a view 
list in order to make it easier for important messages to stand 
out. For this we access Conditional Formatting from the View 
Settings dialog box. 

 

 To access Conditional Formatting, select the View tab on the 
Ribbon, then View Settings, Conditional Formatting. Once 
selected, set the Condition, then the Font options. 

QuickSteps 

QuickSteps are an easy to use method of applying multiple 
actions on one or more selected messages regardless of 
criteria within the messages. This is how QuickSteps differs 
from Rules. However, for this reason you must select and 
apply the QuickStep manually. We access QuickSteps from 
the Home Tab. We decide on the actions to be performed 
and any related settings such as the folder name or category 
name. Note that we can assign a Shortcut Key to make the 
QuickStep more accessible. 

 

 To create a QuickStep, select the Create New option from within 
the QuickSteps gallery on the Home tab on the Ribbon. Once in 
the QuickSteps dialog box enter the name, action(s) and 
parameters based on your requirements and click OK to complete. 

 You can create many QuickSteps based on your needs. 

 QuickSteps are applied to selected messages as required. 

 When applying a QuickStep to selected messages, please be sure 
only the messages which require ALL actions are included in the 
selection. 

 You cannot undo a QuickStep. To reverse actions performed by a 
QuickStep, you will have to do them manually. i.e. Move messages 
out of the folder, remove the Category, etc. 

 Rules 

Rules are one of the most popular and powerful features for 
automating email handling. When implementing Rules, it’s 
important to plan for the kind of criteria which will ‘trigger’ the 
actions that the Rule is designed to perform. For example, will the 
Rule perform its actions based on the Sender name or content in 
the Subject field or a combination of several criteria values? There 
are 3 steps to go through in the creation of a Rule: 

 Condition(s) – this will be the criteria within the message that 
determines what the action should be based on messages that have 
this condition 

 Action(s) – this will be the step(s) to perform on the message once it 
has been determined that it meets the criteria values 

 Exception(s) – this will be the specific exceptions which will cause the 
message to be excluded from having the action(s) performed 

 

A user can have many Rules configured so that many or most 
messages that arrive in the user’s Inbox are automatically 
processed. Rules can be edited at any time should the criteria or 
actions need updating.  

Allow Rules to do the bulk of the email management for you! This 
means you will only be left with those messages which are 
exceptions to the criteria used in your Rules. The more that you 
can get Rules to do your email handling, the better. 

Note: Most Rules can only run when the user’s workstation is 
running Outlook. Rules cannot be undone but can be manually 
reversed in most cases. 

Examples of messages to manage with Rules 

 Common client messages 

 Common coworker messages 

 Common projects messages 

 Common subject line messages 

 Common distribution list messages 

 Any other items which are routinely managed through the use of 
folders, categories or flags. 

Creating a Rule 

 Select the Rules drop down button on the Home tab on the Ribbon.  

 Click Create Rule command  

 Apply criteria and actions or click Advanced Options for step-by-step 

 Step 1 – Specific the condition or criteria in the messages arriving 

 Step 2 – Specify the action to be applied to messages 

 Step 3 – Specify any exceptions to exclude messages based on criteria 

 Step 4 – Provide a meaningful name for the Rule and test on Inbox 

Once you’ve created your Rules, you can back them up by 
accessing the Manage Rules and Alerts dialog box. Click Options, 
Export Rules to save your rules in a file. You can then use Import 
Rules if Outlook must be reinstalled or updated. 

 


